DRaFT Tutorial

Ken Saito & Gregg De Young

1 Introduction

Diagrams in mathematical manuscripts often exhibit individualistic characteristics, damage,
and sometimes inaccuracies (figure 1) that are almost impossible to preserve or reproduce apart
from modern photographs or high-quality digital scans. Obtaining these reproductions is often
costly and time-consuming. Moreover, the individual characteristics and imperfections of these
diagrams can at times obscure their reason for existence — to communicate mathematical and
geometrical information visually. DRaFT software was developed specifically for use in studying
and editing these mathematical diagrams.
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Figure 1: A page of a typical mathematical manuscript including a diagram. This example is
from a medieval Arabic manuscript on optics.

As we can see in this diagram, not all the lines are completely visible (the ink is apparently



flaking off the page) and not all the lines meet exactly as they should in a true mathematical
world. The DRaFT software tools were designed for editing just such mathematical diagrams.
The software allows us to capture and preserve the essential geometrical information included
in the diagram, manipulate it in various ways, and produce a print-quality EPS graphics file
that can be imported into many print applications. In this tutorial, we demonstrate the basic
editing of a geometrical diagram in order to illustrate the operations of the software.

2 Preliminaries

DRaFT software is built on Java technology. This allows the software to run on all common
platforms, such as Windows, Mac OS, and Linux. You will need a recent version of Java installed
on your computer in order to use DRaF your computer does not have Java installed, it can
be downloaded from the internet.

Unzip the Draft package and install the DRaFT files in a folder in a convenient location. To
open the DRaFT program, open the DRaFT folder and double click the Scriptorium Executable
Jar File. You should see the DRaFT editing console (figure 2).
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Figure 2: The DRaFT editing console.
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3 Data Files

For our tutorial, we will edit the optics diagram in figure 1.! DRaFT requires that its data to be
in JPG format. If the data is in another format, convert it to JPG files. One way to do this is
to import the diagram into a utility like Paint and save it as a JPG file. It is usually convenient
to keep all your DRaFT data in one folder. For efficient use of time, convert all picture files
into JPG format before starting to edit the data files. It is also advisable to crop the JPG files to
keep the data files as small as possible and to avoid distractions while editing the image. Since
in this case our image is already in the required JPG format, we need only to crop the image
to extract the diagram. A utility such as Paint or Windows Office Picture Manager can perform
this function easily. Save the results in the DRaFT Data file.

4 Preparing to Edit

The DRaFT editing console consists of several components: DRaFT edit screen, menu bar, opera-
tion icons, points edit window, point data screen, shapes edit window, and groups edit window.
The specific functioning of each component is described in the DRaFT Reference Manual. Since
we will refer to many of these features during this tutorial, take a few minutes to become fa-
miliar with the DRaFT editing console and the position of its component features (figure 3).
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Figure 3: Components of the DRaFT console labeled in red.
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4.1 Import a JPG image to be edited

Open the Background tab on the menu bar and select Set Background Image. A dialog window
opens allowing you to navigate to the desired image. (HINT: If working on a large project
requiring editing of multiple diagrams, it is useful to store all the JPG data files in one folder.)
Click Open to import the image. The image now appears on the edit screen (figure 4).
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Figure 4: The DRaFT editing console with imported image. The red dotted lines mark the
boundary of the picture calculated by DRaFT.

Sometimes the imported image is too large to work with conveniently on the edit screen.
It is possible to reduce the size of the image using an external utility such as Microsoft Picture
Manager to scale down the original image. But DRaFT itself contains a useful tool to resize
images. To reduce the image to more manageable size, open the Background tab on the menu
bar and select Set Image Transformation. A dialog window opens. In the Magnification field,
enter an appropriate value and click Save to apply your changes (figure 5). Altering the image
size does not alter the geometric information we wish to capture and preserve. The dialog
window also allows us to move the image or rotate the image on the edit screen.

Some users find the grid lines of the edit window distracting. The grid may be toggled off
by opening the Options tab on the menu bar and unchecking Show Grid. The size of the grid
squares can also be altered under the Options tab.
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Figure 5: The DRaFT editing console with reduced image. The grid lines have been turned off.

4.2 Import a styleset

Open the Styles tab on the menu bar and select Load Styles. A dialog window opens allowing
you to navigate to the desired styleset. The DRaFT package contains two basic stylesets, one
for editing and one for printing. Navigate to the styleset Linestyle_Edit and import / open it.
The name of the current styleset is displayed at the top of the DRaFT console. A new styleset
can be loaded at any time in the edit process. The open styleset will always govern the current
drawing, including whatever editing you have already done.

5 Editing the diagram

DRaFT registers points by recording their position on the edit screen in terms of pixels. It then
joins these points together following user specifications to create lines that compose shapes.
So the first step in editing a drawing or diagram is to register its important points (usually
endpoints of line segments or intersections of lines).

5.1 Registering points

The order in which points are registered is not important. Position the cursor on the diagram
point to be registered, press Control and left-click to insert the point. (Alternatively, click the
Add Point operation icon — second from left — position the cursor on the point, and left-click



to register the point.) A red dot indicates the point on the edit screen. The coordinates of the
point appear in the Points Edit window. Whenever a new point is added, the previous point’s
color changes to blue. Only the currently selected point will be highlighted in red. Its identifier
number will appear in the Point Data Window (figure 6).

When the desired points have been registered, click the Select icon. This action exits Add
Point mode so that unwanted points are not accidentally inserted into the diagram. (HINT: If a
point is inserted incorrectly, select it and click Remove in the Points Edit window. WARNING:
Deleting a point used to define a shape will delete that shape.)
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Figure 6: Screenshot of the DRaFT edit console showing some registered points. The currently
selected point is highlighted in red (those not selected are shown in blue). Its coordinates are
highlighted in the Points Edit Window and its identifier (19) is shown in the Point Data Screen.

5.2 Adding straight lines

After registering the points, we must tell DRaFT how to connect them. One of the easiest
operations is to connect points to form line segments. Click the Add Line icon — third from
the left on the Operations Bar. (Alternatively, open the Operations tab on the menu bar and
select Add Line — or use the keyboard shortcut indicated there.) DRaFT prompts us to select
a start point and then to select another point. It is possible to connect multiple points together
to form a single shape. It is also possible to connect a single point into multiple shapes. (HINT:
We recommend in general to use only simple line segments defined by two endpoints, rather
than constructing complex shapes from multiple line segments. If it later becomes necessary to



edit the position of one of the points used in a complex shape or in multiple shapes, the action
may affect the entire shape.) Any registered point may be selected as the start point. Then
select another registered point. A red line appears connecting the two points. The identifiers of
the component points (and their labels if they have been assigned) connected to form a shape
are registered in the Shapes Edit Window (figure 7). DRaFT continues to prompt for additional
points to add to the shape. If a needed point has accidentally not been registered, it can be
added by Shift-Ctrl-Right Click. To finish the shape and exit Add Line mode, press escape or
any operations icon (alternatively, click the Select icon).
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Figure 7: Screenshot of the DRaFT edit console showing some registered lines. The currently
selected shape (line) is highlighted in red (those not selected are shown in blue). Its definition
(list of component points) is highlighted in the Shapes Edit Window.

Our goal is to create lines that fall precisely on the lines of the original image. If the line
segment does not coincide with the line of the image, most probably one of the points defining
the line is not positioned correctly. The position of any point may be edited in several ways:

* Click the Select button of the operations icons then click the point to select it. The selected
point is highlighted in red. Use drag and drop to reposition as desired.

» Move the point one pixel in any direction by pressing Shift and the appropriate arrow key.
Repeat as needed to achieve the desired position.

« In the Point Edit window, select a point by highlighting its coordinates, then click Edit. A
dialog window opens indicating the current parameters defining the point. Any parameter
may be changed, offering various options for editing the point’s characteristics. To change



position, replace the current coordinates with the desired coordinate values. Press save.
Repeat as needed in order to place the point in the desired position.

5.3 Adding curved lines

DRaFT offers several options for constructing closed curves or curved line segments:

» Draw a circle using its center and a point on the circumference

» Draw an ellipse using its two foci and a point on the circumference

» Draw a circular arc using its endpoints and a random point on the arc
« Approximate an irregular arc using one or more Bézier curves

« Approximate a circle from a set of points on its circumference

» Approximate an ellipse from a set of points on its circumference

Our diagram contains several arcs. Because arcs are defined by their endpoints and an
arbitrary point on the arc, it is necessary to insert an additional random point on each arc.
Then click the Add Arc icon from the operations icons or select Add Arc from the Shapes tab
on the menu bar or use the keyboard shortcut noted there. DRaFT prompts for a beginning
point, an end point, and a point on the arc (figure 8). WARNING: Start and end points must be
specified in the correct order. DRaFT always draws the arc in a clockwise direction on the edit
screen. Choosing start and end points incorrectly produces the complement of the desired arc.

(HINT: If the internal shading of the shapes is not desired or becomes confusing, this feature
can be toggled off. Open the Options tab on the menu bar and uncheck Show Own Shading.)

5.4 Using Bézier curves

Diagrams in manuscripts are frequently imperfect. When faced with an irregular ovoid rather
than a true ellipse or circle, for example, it is often useful to break the shape into several
parts and use a Bézier curve to approximate each part. To illustrate the use of this important
operation, a Bézier curve will be used to approximate the selected circular arc in figure 8.

From the operations icons select Bézier Curve (located to the right of the Add Arc operation
icon) or use the Shapes tab on the menu bar. The Bézier curve requires a start point, an end
point, and two randomly placed “control points”. In this operation, the order of start point and
end point is not important. Once the required points have been selected, DRaFT draws a curve
(figure 9). This curve probably does not lie very close to the desired position.

Using drag and drop, move one of the two control points. Notice that the shape of the Bézier
curve changes as the point moves. Move the control point until the curve comes closer to the
desired final position and shape. Then move the other control point, again trying to get the
Bézier curve to fit more closely to the desired final shape and position. Continue to alternate
between the two control points until the desired result is obtained (figure 10).

5.5 Adding labels

The final step in editing the diagram is to add labels. The label is an attribute of a point. A
point may have only one label. The label may be a single character or string of characters. The
label may be in any language for which there exists a unicode font. (HINT: In a few diagrams,
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Figure 8: Screenshot of the DRaFT edit console including some curved elements of the drawing.
The lower arc is highlighted in red, indicating that it is currently selected. Non-selected arcs
are shown in blue.

there may be more labels than points to which they can be attached. In this case, it is possible
to add additional points anywhere in the diagram since there is no necessity that the label be
placed near the point to which it is attached.)

To insert a label, select the point to which the label is to be attached. While holding down
Ctrl and Alt keys and left mouse buttons, draw a small box to define the center of the label.
(NOTE: if the “Show Own Shading” feature has been turned off, the label box and its central
cross will still be shown on the edit screen.) The precise shape and size of the box is unim-
portant. DRaFT uses the intersection of the diagonals to position the label. The label may be
repositioned, if necessary, by re-drawing the position box in a new location. (HINT: Label font
and font size can be adjusted by editing the linestyle — described in section 6.)

To insert labels in non-Roman scripts: if the computer has the appropriate keyboard map
enabled, these labels can be typed directly from the keyboard. If the needed keyboard map
is not enabled, it is still possible to insert the desired characters. Open a word processing
document and type or insert the desired character(s) using the font specified in the linestyle
— the default is Times New Roman. Copy the character(s) from Microsoft Word (Ctrl-c) and
paste (Ctrl-v) into the Label field of the Point Data Window after defining the label’s position
box. NOTE: the modern print font may not mirror all orthographic features of the ancient or
medieval hand-written character in the manuscript diagram.

In some diagrams, one or more labels may to oriented along an axis that is not parallel to
the axes of the edit window. (In this example, the labels along the two slanted lines of the
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Figure 9: Screenshot of the DRaFT edit console showing the initial Bézier curve in red. The two
control points are shown in black. Non-selected points and lines are shown in blue.

upper part of the diagram are inserted at an angle approximating that of the lines themselves.)
If it is desired to show this attribute of the edited drawing, select the point to which the label is
attached, either using the Select icon and clicking the point or by clicking its coordinates in the
Points Edit Window. Then click the Edit button. A dialog box opens in which various attributes
of the point may be specified. Enter the desired degree of rotation as measured in relation to
the horizontal axis (figure 11).

When checking the appearance of an edited image, it may sometimes be useful or desir-
able to turn off temporarily the labels that have been inserted into the edited drawing. Under
the Options tab on the menu bar, click show/hide labels. The labels are suppressed but the
label boxes remain visible. Click show/hide labels again and both labels and label boxes are
suppressed. Click show/hide labels a third time and both labels and label boxes are restored.

There may be situations in which one wishes to reuse diagrams whose labels are in one
script in another study in which labels in another language script are appropriate. For example,
one may wish to reuse several diagrams whose labels have been inserted in Arabic script in a
new study requiring that the diagrams be labeled using Roman script. It is not necessary to
re-edit all the drawings, manually changing all the labels from one script to another. Under the
Operations tab on the menu bar, select Transliterate Labels. In this operation, you specify the
conversion table to be used and the DRaFT files to which it is to be applied. (See the Reference
Manual for additional information on conversion tables and their use.)
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Figure 10: Screenshot of the DRaFT edit console showing the final Bézier curve in red. The two
control points are shown in black. Non-selected points and lines are shown in blue.

5.6 Checking the drawing

To check the editing of a diagram at any time, use the Hide feature under the options tab on the
menu bar. Type Ctrl-b and the background image is suppressed, leaving only the edited drawing
visible. Type Ctrl-b again and the image is restored while the edited drawing is suppressed. Type
Ctrl-b a third time and both background image and edited drawing are restored.

To make a final check of the editing, save the edited diagram and view the EPS output file
produced by DRaFT. To do this, open the File tab on the menu bar and select Save As. A dialog
window opens in which the file name and location where the file will be saved can be specified.
(HINT: it is recommended to save all drawings from a project in a dedicated subfolder within
the DRaFT Data folder.) DRaFT automatically creates an EPS output file while saving the XML
data file. Navigate to the DRaFT data folder. Open the appropriate EPS file using Ghostview
or other EPS viewer. The drawing appears exactly as it did on the edit screen — the points are
registered as dots and the lines and are connected by line segments the same color as those seen
on the edit screen (figure 12). Check the EPS view carefully. If further editing is needed, return
to DRaFT and make the necessary changes in the drawing.

5.7 Preparing to print

When the preliminary EPS output file is satisfactory, we are ready to produce the final EPS print
output. Return to DRaFT, open the Styles tab, select Load Styles, and open Linestyle_Print. This
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Figure 11: Screen shot of the DRaFT edit console showing the insertion of labels. A selected
point (highlighted in red) has its label box drawn large enough to show the label positioned
inside the label box. Note the rotated labels along the slanted line.

styleset converts all lines and labels to black and reduces points and position boxes to invisible
dimensions. Save the file as before. DRaFT automatically suggests the name of the existing
XML data file. (HINT: Choosing this suggested name will overwrite the previously saved XML
file. It is recommended to give the file a modified name — perhaps by adding “P” to the file
name — so that one can return to the earlier XML data file if necessary.)

The EPS file is now ready for a last final check to make sure the diagram is as desired (figure
12). If no further editing is required, the EPS file of the edited diagram is ready for use. (If using
a PDF-version of LaTeX or XeLaTeX, the EPS file must be converted to PDF. There are several
free conversion programs available, either for personal download or online conversions.) The
diagram can be imported into LaTeX documents or many word-processing programs, imported
into Power Point presentations, or printed.

6 Creating special effects

Suppose we wish to use the EPS drawing in a power point presentation. Moreover, we wish to
emphasize the two slanted lines in the upper drawing by coloring them red. We also want to
distinguish one from the other — perhaps by making one of them a dashed line rather than a
solid line. In addition, we notice that the small hash marks indicating the positions of the two
intermediate points on the long horizontal line in the lower portion of the picture are not yet

12



G.

C

Figure 12: Left, the test EPS file. Right, the final print version of the EPS file.

represented. Of course, one could simply add these very short line segments as was done in
section 5.2, but this procedure is somewhat difficult when the endpoints of the line are so close
together. Instead, let us use the point dots themselves to mark the location of these two hash
marks (figure 13). To produce these effects (and many others) it is necessary modify the default
print styleset. (NOTE: if it is desired that these modifications be visible also while editing the
diagram, it will be necessary to modify the default edit styleset as well.)

[
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C

Figure 13: The final version of our diagram, including the special effects.

EDiting the stylesets to create these and many other special effects is a simple process in
DRaFT. To begin, load the default linestyle_print styleset using the Styles tab on the menu bar.
From the Styles tab, select Edit Styles. A dialog window opens listing currently defined linestyles
(default = solid; lost = dotted; border = dashed lines). The first thing to decide is whether
to edit one or more of the existing linestyles or to create a new linestyle. In general, the latter
approach is recommended. Click Add. A new window opens allowing definition of attributes
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of a new linestyle. Assign a name to the new linestyle for example, reddefault). Select Element
Color and Font Color — in this case, we wish the element color to be red but the font color to be
black. Use the menus to change any other attributes as desired. NOTE: the default font size for
the three basic line styles is 24. It is recommended to use the same font size in the new linestyle.
(WARNING: a font name must be entered before the linestyle will be saved. The default font
of the original linestyles is Times New Roman.) Save to register the new linestyle. Additional
line styles may be added in the same way. Repeat the process to create a new linestyle (called
redborder) in which the element color is red and the line itself is dashed.

After the new linestyle has been saved, return to the DRaFT edit screen and select the lines
that are to appear in red — left-click anywhere on the line or click on the definition of the line
in the Shapes Edit Window. The definition of the selected line will be highlighted in the Shapes
Edit Window and the line will be highlighted in red on the edit screen. Click the Edit button.
A new window opens detailing the current attributes of the line which may be changed. Open
the Style menu and select the linestyle to be applied to the line. (HINT: if any point connected
to this shape has been given a label, the attributes of that label will also be changed to conform
to the parameters specified in the linestyle definition.) Click Save to apply the changes.

We also want to create a linestyle in which the points are not reduced to zero in the print
output so that the dots representing the hash marks on the horizontal line remain visible. Click
Edit Styles, and Add a new linestyle — named default(points) or any other convenient name.
As before, select the attributes desired for this line style (such as line width = 0 and point size
= 8), and click Save. In the DRaFT edit screen, select the points to be edited by highlighting
the coordinates of each point in the Points Edit Window. Since the point attributes are defined
in relation to lines and linestyles, it is necessary to insert a new line between the two points we
wish to appear as dots. In the Shapes Edit Window, select the new line and click Edit. In the
dialog window, select the lineststyle and Save.

Save the edited file again and check the EPS output file (figure 13) to be sure everything is as
intended. The edited figure now exhibits the characteristics we wished to create and emphasize:
one of the slanted lines is red, the other is also red but constructed as a dashed line. The two
points on the long horizontal line are shown as dots. There are many different special effects
that might be created using the potential of DRaFT.

7 The future is yours

DRaFT is very flexible and easily customized to meet user needs. In our tutorial we have de-
scribed how to change some of the basic characteristics of DRaFT output. More advanced users
may create their own customized version of DRaFT by editing the default settings. Since the
defaults are written in XML code, the customization is a simple process. (See the Reference
Manual for additional information on editing default settings.) Using DRaFT’s many options,
one is capable of editing almost any traditional mathematical diagram.

We hope that you have found this short tutorial a useful introduction to DRaFT. Please refer
to the Reference Manual for additional information about the many capabilities of the software.

If there are additional features that might be incorporated into DRaFT to increase the use-
fulness of the software, please tell us your requests. The program is still under development
and will hopefully become even more powerful and flexible in future releases.
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